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Introduction



Preface

Thank you for choosing Taleo Enterprise EditionTM. This document provides important information 
regarding Taleo Anywhere.

About this document
This document contains instructions for the installation of Taleo Anywhere and descriptions of Taleo 
Anywhere features available to clients who purchase and install the product. For many features, the 
information is presented in the following manner:

• Feature description: a brief presentation of the feature.

• Key benefits: benefits of implementing the feature.

• Things to consider: constraints related to the feature (for example, things that the feature will not 
accomplish). Also, migration, integration and reporting impacts are indicated for each feature, when 
needed. To be aware of all migration related information (including prerequisites and general 
impacts), the most appropriate source of information is the Client Upgrade Toolkit 7.5. This document 
is available on the Web Support Toolbox, in the Taleo 7.5 section. If you do not have access to the 
Toolbox, please communicate with Taleo Customer Support.

• How to use the feature: how the feature works, permissions and settings associated with the feature 
where applicable.
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Technical Requirements

For detailed information on technical requirements, refer to the Taleo Enterprise 7.5  Technical 
Requirements and Configuration Guidelines for Taleo Enterprise Users for the applicable service pack. 
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User Types that Can Create 
Candidates and Access the 
Address Book In Taleo Inbox

Assistant 1 

Assistant 2 

Collaborator 1 

Collaborator 2 

Hiring Manager 4 

Hiring Manager 5 

Recruiter 1 

Recruiter 2 

Recruiter 3 

System Administrator 

System Integration 

Unrestricted User 
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Users Who Have Access to 
Performance Management 
from Taleo Inbox

Any user who has an account in Performance Management.
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Installing Taleo Inbox 

Identifying Your Taleo Inbox User Name and Password

You will require a user name and password for Taleo Inbox during installation of the product. This is the 
same username and password that you use when logging into Taleo Recruiting and/or Taleo 
Performance.

If you use SSO and you do not know your Inbox user name and password or need to create a new 
password, perform the following steps.

Prerequisite

You must be a Staffing WebTop or Manager WebTop user.

Your organization must have activated the Enable Password Change permission.

Path: Staffing WebTop or Manager WebTop > My Setup > My Setup > (Account Information) Edit

Steps

1. On the User Account Editor page, your Taleo Inbox user name is displayed in the corresponding 
field. It is recommended that you record this information in a safe place.

2. To replace your existing password, enter a new one in the Password and Confirm Password fields.

3. Click Save. 

Installing Taleo Inbox on Users’ Workstations 

Prerequisite 

Taleo Inbox must be set up via an Active Directory startup script.

You must know your user name and password for Taleo Inbox.  

Microsoft Outlook must be closed.

Steps

1. Open the setup folder (from a CD-ROM, the network or a local directory on your computer). 

2. Double-click the Setup.exe program. You can install the plug-in in any directory; just select the 
directory during the installation. 

3. Follow the on-screen instructions to complete the installation and restart your computer if requested. 

Result: Users can now use Taleo Inbox. 

Next step: Starting Taleo Inbox for the First Time

Setting Up Via an Active Directory 

This section provides an example of how to set up the Taleo Inbox plug-in for Microsoft Outlook via an 
Active Directory startup script. 
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Prerequisite 

Domain Controller 
1. On a domain controller, open Active Directory - Users and Computers. Right-click an organizational 

unit that contains the computers on which you want to install the Taleo Inbox plug-in. Click New and 
then assign a name to your new policy. 

2. Make sure that your new Group Policy Object Link is highlighted and then click Edit. In the Group 
Policy Object Editor window that is displayed, navigate to Computer Configuration > Window 
Settings > Scripts (Startup/Shutdown) > Startup. 

3. Right-click Startup and then click Properties. Click Show Files... in the Startup Properties window that 
is displayed. 

4. Copy the Taleo Inbox plug-in for Microsoft Outlook setup files to the location that appears in the 
new Windows Explorer. The location will be similar to: 
\\domain.local\SysVol\domain.local\Policies\<GUID>\Machine\Scripts\Startup. 

5. In this new directory, create a new batch file called Setup.bat. 

6. Edit the following line and then copy and paste it into the batch file: 

msiexec /italeo.plugins.msoutlooksetup.msi /quiet taleohostname=“http://www.taleo.com“

7. Replace “http://www.taleo.com/“ by your actual Taleo server hostname. 

8. Click Add... in the dialog from the previous step. Click Browse... and then choose the Setup.bat files 
that you copied in the previous step. 

9. Click OK twice, close the Group Policy Object Editor and click Close for the organizational unit’s 
properties. 

Result: Your Group Policy is now ready to automatically distribute the client via a Machine Startup script. 

After Completing This Task: Taleo Inbox is now ready to be installed on workstations. If a previous 
version of the plug-in is installed, you can create an Uninstall.bat file and follow the same procedure to 
uninstall the old plug-in before installing the new one. Use the following command line in the batch file: 

msiexec / uninstall taleo.plugins.msoutlooksetup.msi /quiet 

Starting Taleo Inbox for the First Time

Some configuration is required the first time you start Taleo Inbox.

Prerequisite

Taleo Inbox must be installed on your computer.

Steps

1. The first time you start Taleo Inbox, a Taleo Products window is displayed.

2. Click the check box next to Do not ask me this information again if you do not want the window to 
be displayed in future.

3. Click Scan for Products.

4. When the First Time Sign In window is displayed, do not click Create Taleo Password. Click 
Continue.
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5. In the Taleo - Server Address field, enter the correct address for your organization (this information is 
typically provided by your system administrator) and click OK.

6. When the User Sign In window is displayed, enter your Taleo Inbox user name and password in the 
corresponding fields.

7. Click the check box next to Remember Me if you don’t want this window to be displayed in future.

8. Click Sign In.
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Configuring Taleo Inbox 

From within the Taleo Inbox Configuration window you can set the language you want the application 
to use, specify performance management and recruiting options available from within Taleo Inbox, 
reset your user name and password, change the Taleo hostname.

Path: Microsoft Outlook

1. In the Microsoft Outlook menu bar, click Taleo and then click Options... in the list. The Taleo Inbox 
Configuration window opens.

2. Click the language selector and then click the language you want Taleo Inbox to use. 

3. Click OK. Taleo Inbox will use the language you selected the next time you start Microsoft Outlook.

4. Click Change Taleo Server Address to enter the Taleo hostname used by your organization.

5. Click Scan for Products...

6. Click Performance Management Options and specify the performance management options you 
want to make available in the Taleo menu and the Taleo Inbox toolbar.

7. Click Recruiting Options... to specify the following options.

• Candidate Default Language: Specify the default language for the candidates’ resume. The 
languages in this list are identical to the languages specified in the database (company setting: 
CompanyContentLanguages). If only one language has been activated in the zone, there is no 
drop-down list. The language you select appears automatically in the Candidate Resume 
Language field when you create candidates.

• Candidate Default Country: Specify the candidates’ country. The country you select appears 
automatically in the Candidate Information window when you create candidates.

• Show Requisition Title: Specify whether you want to display requisitions with the Recruiter Title or 
the Manager Title (as defined on the requisition’s Logistics tab).

• The Taleo recruiting options you want to make available in the Taleo menu, the Taleo Inbox 
toolbar and while composing email messages in Outlook.

Click OK when you are satisfied with your changes.

8. Click Reset Username/Password to reset the user name and password for Taleo Inbox. The system 
will request you to enter the new user name and password the next time your use Taleo Inbox.

The Reset Username/Password function is common to Taleo Sidebar and Taleo Inbox. Therefore, if 
you change your user name or password in Sidebar, you have to use the new values when you log 
into Inbox and Sidebar.

9. Click OK when you are satisfied with your changes. 



Taleo Inbox User Guide

Taleo Inbox

Taleo Inbox is a Web Services-based solution that enables users to take action on various Taleo tasks 
from within their Microsoft Outlook application without the need to login directly to the Taleo 
applications. This includes the ability to execute tasks such as approvals and feedback requests, update 
goals, and launch the Taleo Performance application. It also provides users with the ability to forward 
an email to a Performance Journal that can be referenced later for a Performance Review. 

Detailed Description 
Taleo Inbox provides users with the ability to take action on Performance Management tasks from within 
their most common productivity tool - Microsoft Outlook. All data is exchanged via secure Web 
services. Data is not exchanged via email. 

From Taleo Inbox you can: 

• Respond to a network invitation 

• Respond to a feedback request 

• Update goals 

• Approve/reject approvals (succession plans, reviews, goal plans) 

The Outlook integration enables you to: 

• Send feedback 

• Forward feedback 

Taleo Inbox uses Taleo Web services to send and receive data from/to the Taleo servers; Taleo does not 
use any Exchange or SMTP servers related to Outlook. The Web service authentication is done through 
WS-Security and WSE 2-0; not HTTP Basic so the user name and password are not displayed in clear 
text and there is protection against “Replays“. 

Key Benefits 
• Integration with common productivity tools increases participation rates

• Fully secure 

Taleo Inbox does not use mails or SMTP. It is a Web services offering that uses HTTPS, so it is fully 
secure. Historical transactions are not stored in Outlook or on a Microsoft Exchange server. 

Configuring for Single Sign-On 

Single sign-on (SSO) is a mechanism whereby a single action of user authentication and authorization 
grants users access to all computers and systems (provided the users have the required access 
permission for the computers or systems) without requiring the users to enter multiple passwords. The 
very first time the Taleo Inbox tries to access the Taleo Web servers, the First Time Login screen is 
displayed. 
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Prerequisite 

If your company uses Single Sign-On to access the Taleo Web site, you need to know your Taleo user ID 
and you need to set up a password to use Taleo Inbox. 

1. Click Taleo User Setup (the icon at the bottom of the First Time Login window). This action will open 
your Internet browser and display the My Setup page on the Taleo Web site. 

2. Click Edit next to the Account information section. 

3. On the User Account Editor page, enter a password in the Password and Confirm Password fields. 

4. Click Save and close your browser. 

5. Close the First Time Login window and log in using your user name and your new password. 

Result: Taleo Inbox accesses the Taleo Web servers. 

Using Taleo Inbox for the First Time

Prerequisite 

Taleo Inbox must be installed on your workstation. 

Microsoft Outlook 
1. While attempting to access a Taleo resource via the plug-in for the first time, you might be prompted 

to enter your Taleo hostname. You can copy and paste the URL you are using to access the Taleo 
application from your Web browser. 

If your administrator provided you with a custom setup for the plug-in (or the custom setup was 
installed automatically), you might not need to enter the Taleo hostname yourself. 

2. The first time you open Microsoft Outlook following the plug-in installation, the Taleo toolbar is 
displayed in the middle of the screen. Simply click it and move it to the position you find most 
suitable. 

3. A new “Taleo” item is displayed in the Outlook main menu. You can customize your plug-in by 
clicking Taleo in the menu, clicking Options... and then making your changes. 

Result: You are now ready to begin using Taleo Inbox. 

Displaying the Taleo Inbox Toolbar

Prerequisite 

Taleo Inbox must be installed. 

Path: Microsoft Outlook

1. Click View > Toolbars > Taleo Main Toolbar. The Taleo toolbar is displayed near the Outlook 
toolbar and contains the following icons: Dashboard, Address Book, Create Candidate and Create 
Feedback.

Creating a Candidate

Prerequisite 
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Taleo Inbox must be installed. 

Path: Microsoft Outlook

1. Ensure that the message in Microsoft Outlook that will be used to create the candidate is selected.

2. In the Taleo Inbox toolbar, click Create Candidate. Alternatively, you can click Taleo in the Outlook 
main menu and then click Create Candidate. The system might request you to sign in if you have not 
already done so and you have never selected Remember Me.

3. In the Source File window, click the radio button that corresponds to the person who sent the 
resume.

4. In the Select the resume item section, make a selection: 

• Click the resume filename if it is displayed.

• If a resume is included in the text of the message, click Message Body.

• If there is no resume, click No resume.

5. In the Language field, click the language that corresponds to the one used in the candidate’s 
resume and click Next.

6. On the Candidate Information page, enter the information you have in the corresponding fields and 
click Next.

7. If you do not want to match the candidate to a requisition, click Next and Finish. If you want to 
match the candidate to a requisition, see “Matching a Candidate to a Requisition”.

Matching a Candidate to a Requisition

Prerequisite 

You have started the Create Candidate process and have entered on the Candidate Information page 
the information you have. You must be the owner of the requisition.

1. In the Match Requisition window, enter your search term in the Search for: field, select a search 
category from the Search in: field and then click Search.

If you enter multiple search terms, they are joined by the AND operator (this action is transparent). 
You can use word stems composed of at least 3 characters. For example, you can type “eng” and 
the search engine will retrieve requisitions that contain “English”, “engine”, “engines”, 
“engineering”, “engineer”, etc. If you use multiple search terms, stemming is only applied to the last 
term in the search string.

2. In the Search Results list, click the requisition to which you want to match the candidate and then 
click Add. You can CTRL-click multiple requisitions to select them before clicking Add if you want to 
match the candidate to them.

3. Click Next.

4. On the Select Source page, make the appropriate selection from the Source Type and Source fields. 

5. Click Finish.
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Using the Taleo Recruiting Address Book

You use the Taleo Recruiting Address Book to quickly compose and send a message to a candidate 
(who has a candidate file in your zone) without opening the Staffing WebTop or Manager WebTop.

Prerequisite 

Taleo Inbox must be installed. 

Path: Microsoft Outlook

1. Click New > Mail Message in the Outlook toolbar.

2. Click Taleo Recruiting Address Book.

3. Enter a search term in the Search for: field and click Search. The system might request you to sign in 
if you have not already done so and you have never selected Remember Me.

The search engine will search the first name, middle name, last name, email address and telephone 
number fields in candidate files. If you enter multiple search terms, they are joined by the AND 
operator (this action is transparent). You can use word stems composed of at least 3 characters. For 
example, you can type “Fred” and the search engine will retrieve candidate files that contain “Fred”, 
“Freddy”, “Frederick”, “Frederic”, “Fredericton”, etc. If you use multiple search terms, stemming is 
only applied to the last term in the search string.

4. Click the name of the person to whom you want to send the message and then click the appropriate 
icon in the Message Recipients section: To, Cc or Bcc. You can add multiple recipients by repeating 
this step for each candidate. Of course, it is only possible to select candidates in the search results 
list whose candidate file contains an email address.

5. Click Finish.

6. Enter your text in the Outlook text box and then click Send to send the message.

Viewing Your Tasks 

The Taleo Dashboard enables you to see all the tasks that you have assigned to yourself.

Prerequisite 

Taleo Inbox must be installed.

Path: Microsoft Outlook > Dashboard

1. The system might request you to sign in if you have not already done so and you have never selected 
Remember Me.

2. Scroll down to the Tasks section to see the tasks that you have assigned to yourself.

Responding to an Approval Request 

Someone in the organization might need your approval for an employee review, a goal plan or a 
succession plan. You can respond to this request using Taleo Inbox. 

Prerequisite 

Taleo Inbox must be installed on your workstation. 

Path: Microsoft Outlook > Dashboard
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1. The system might request you to sign in if you have not already done so and you have never selected 
Remember Me.

2. In the Approvals section, locate the approval request to which you want to respond. 

3. Click Approve to approve the request or Reject to deny approval. Confirm your decision in the 
confirmation window that is displayed afterward.

Result: The approval request is no longer displayed in the Approvals section. 

Accessing the Employee Center 

It is possible to go to the Employee Center from Taleo Inbox. 

Prerequisite 

Taleo Inbox must be installed on your workstation. 

Path: Microsoft Outlook > Dashboard

1. The system might request you to sign in if you have not already done so and you have never selected 
Remember Me.

2. Click the Employee Center link.

Result: Taleo Performance opens. 

After Completing This Task: You can perform various actions in Taleo Performance. 

Sending Feedback 

You can create and send feedback from within Taleo Inbox. You can even copy the content of an 
Outlook email message and include it in your feedback.

Prerequisite 

Taleo Inbox must be installed on your workstation. 

Path: Microsoft Outlook 

1. In Microsoft Outlook, ensure that the message you want to provide feedback on is selected.

2. Click Create Feedback in the Taleo Inbox toolbar. The system might request you to sign in if you 
have not already done so and you have never selected Remember Me. 

3. In the Create a new Feedback window, click the ... icon next to the About field and then click the 
radio button next to whom the feedback will be about: yourself or one of your direct reports. 

If you clicked About one of my direct reports, click the person’s name in the list of direct reports. 

Click OK.

4. Click the ... icon next to the Subject field and then click the type of feedback that is most 
appropriate: Goal, Scenario, Job Role or Competency. 

Click the appropriate goal, scenario, job role or competency in the list that is displayed and then 
click OK.

5. Type and format (using the formatting tools provided) your feedback. 

6. Click Copy email message if you want to include the original email message in your feedback.
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7. Click Send Feedback. 

Result: In the case of an employee review, the feedback is sent to the journal. In the other cases, the 
feedback is sent to the manager. 

Responding to a Feedback Request 

Someone within the organization might want to get your feedback about a goal, a succession plan, etc. 
This person sends you a feedback request to which you can respond using Taleo Inbox. 

Prerequisite 

Taleo Inbox must be installed on your workstation. 

Path: Microsoft Outlook > Dashboard

1. The system might request you to sign in if you have not already done so and you have never selected 
Remember Me.

2. Scroll down to the Feedback Requests section, locate the feedback request to which you want to 
respond and click the corresponding Open. 

3. In the Feedback Requested window, read the message and then click Begin Feedback. 

The list of items requiring feedback from you is displayed in the Feedback Items section. You must 
provide feedback for every item in the list. 

4. Assign a rating to the item by selecting the appropriate number of stars in the Rating section. 

5. Enter your feedback for the first item on the list. You can format the text using the formatting tools 
provided. 

6. Perform one of the following steps:

• If there is only one item in the Feedback Items section, click Finish and Save.

• If there is multiple items in the Feedback Items section, repeat the previous steps for each item in 
the list. When you’re done, click Finish and send. 

7. Click OK to send your feedback.

Result: Your feedback is sent to the person who requested it and the feedback request is no longer 
displayed in the Feedback Requests section of Dashboard.

Responding to an Approval 

In the Taleo Dashboard, you can approve or reject approval requests. 

Prerequisite 

Taleo Inbox must be installed on your workstation. 

Path: Microsoft Outlook > Dashboard 

1. In the Approvals section, locate the approval request and click the corresponding Approve to 
approve the item (for example, a goal plan) or Refuse to reject the item. 

2. Click OK to confirm your decision. 

Result: 

The approval request is no longer displayed in the Approvals section. 
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Responding to a Network Invitation 

In the Taleo Dashboard, you can see who has invited you to be a part of his/her personal network 
within the organization. You can either accept or reject these invitations. 

Prerequisite 

Taleo Inbox must be installed on your workstation. 

Path: Microsoft Outlook > Dashboard 

1. In the Network Invitations section, locate the invitation and click the corresponding Accept to accept 
the invitation or the corresponding Refuse to reject it. 

2. Click OK in the confirmation window to confirm your decision. 

Result: 

The invitation is no longer displayed in the Network Invitations section. 

Updating a Goal 

Prerequisite 

Indication of the prerequisite task to be done before this one.

The following steps apply to a quantitative goal, not to a qualitative one.

Path: Microsoft Outlook > Dashboard 

1. In the Goals section, locate the goal that you want to update and modify the progression 
percentage. 

2. Click Save. 

Adding a Comment to a Goal 

Prerequisite 

Path: Microsoft Outlook > Dashboard

1. The system might request you to sign in if you have not already done so and you have never selected 
Remember Me.

2. In the Goals section, click the goal to which you want to add a comment. 

3. Click Add a Comment. 

4. Enter your comment in the Add a Comment window. 

5. Click Add and Close. 

Result: Your comment is now displayed in the goal’s list of comments. 

Viewing a Comment for a Goal 

Prerequisite 

Taleo Inbox must be installed on your workstation. 
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Path: Outlook > Dashboard 

1. In the Goals section, click the goal that contains a comment you want to view.

2. Click the comment you want to view.

3. Click View.

Taleo Inbox and Outlook in Offline Mode

If you place Outlook in offline mode (File > Work Offline), you cannot perform tasks related to Taleo 
Inbox. You can begin using Taleo Inbox again as soon as you place Outlook in online mode.
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About Taleo Sidebar

Taleo Sidebar is a component that plugs into your Microsoft Internet Explorer browser 7 (recommended 
environment) or 6 (supported environment). You capture candidates directly into Taleo Recruiting 
without having to quit the active browser window. You can drag a candidate’s resume to the Sidebar (or 
copy and add the resume), complete some fields and select matching requisitions.

Key Benefits

• You can capture candidates directly while browsing job boards or other online resources using 
Internet Explorer.

• If a candidate’s resume is displayed on a Web page, you can easily copy and paste it into Sidebar.

• You can quickly indicate the language of a candidate’s resume.

• Taleo Sidebar enables you to be productive even when you have not opened a Taleo product.

Things to Consider

• During installation, previous versions of Taleo Sidebar if present are detected and all unnecessary 
registry entries and associated files are removed.

• A procedure is available that removes the files and registry entries related to Taleo Sidebar and 
returns Internet Explorer to its previous state. If you want to remove Taleo Sidebar for any reason, 
please contact your Taleo client executive for more information on the procedure.



Installing Taleo Sidebar

During installation, previous versions of Taleo Sidebar if present are detected. All unnecessary registry 
entries and associated files are removed.

Prerequisite

Internet Explorer must be closed.

1. Open the setup folder (from a CD-ROM, the network or a local directory on your computer).

2. Double-click the Setup.exe program. You can install the plug-in in any directory; just select the 
directory during the installation.

3. Follow the on-screen instructions to complete the installation and restart your computer if requested.

Setting Up Via an Active Directory 

This section provides an example of how to set up the Taleo Sidebar plug-in for Microsoft Outlook via 
an Active Directory startup script. 

Prerequisite 

Domain Controller 
1. On a domain controller, open Active Directory - Users and Computers. Right-click an organizational 

unit that contains the computers on which you want to install the Taleo Sidebar plug-in. Click New 
and then assign a name to your new policy. 

2. Make sure that your new Group Policy Object Link is highlighted and then click Edit. In the Group 
Policy Object Editor window that is displayed, navigate to Computer Configuration > Window 
Settings > Scripts (Startup/Shutdown) > Startup. 

3. Right-click Startup and then click Properties. Click Show Files... in the Startup Properties window that 
is displayed. 

4. Copy the Taleo Sidebar plug-in for Microsoft Outlook setup files to the location that appears in the 
new Windows Explorer. The location will be similar to: 
\\domain.local\SysVol\domain.local\Policies\<GUID>\Machine\Scripts\Startup. 

5. In this new directory, create a new batch file called Setup.bat. 

6. Edit the following line and then copy and paste it into the batch file: 

7. msiexec /italeo.plugins.msoutlooksetup.msi /quiet taleohostname=“http://www.taleo.com“.

8. Replace “http://www.taleo.com/“ by your actual Taleo server hostname. 

9. Click Add... in the dialog from the previous step. Click Browse... and then choose the Setup.bat files 
that you copied in the previous step. 

10.Click OK twice, close the Group Policy Object Editor and click Close for the organizational unit’s 
properties. 

Result: Your Group Policy is now ready to automatically distribute the client via a Machine Startup script. 
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After Completing This Task: Taleo Sidebar is now ready to be installed on workstations. If a previous 
version of the plug-in is installed, you can create an Uninstall.bat file and follow the same procedure to 
uninstall the old plug-in before installing the new one. Use the following command line in the batch file: 

msiexec / uninstall taleo.plugins.msoutlooksetup.msi /quiet 

Configuring for Single Sign-On

Single sign-on (SSO) is a mechanism whereby a single action of user authentication and authorization 
can permit users to access all computers and systems where they have access permission, without the 
need to enter multiple passwords. The very first time the Taleo Sidebar will try to access the Taleo Web 
servers, the First Time Login screen will be displayed. 

Prerequisite 

If your company uses Single Sign-On to access the Taleo Web site, you will need to set up a password 
to use the Taleo Sidebar. 

1. Click Taleo User Setup (the button at the bottom of the First Time Login window); this will open your 
Internet browser and open the My Setup page on the Taleo Web site. 

2. Click Edit next to the Account information section. 

3. In the User Account Editor page, enter a password into the Password and Confirm Password fields. 

4. Click Save. 

5. Close your browser. 

6. Close the First Time Login window and log in with your user name and your new password. 

7. Result: Taleo Sidebar will access the Taleo Web servers using this password. 

Displaying Taleo Sidebar in 
Internet Explorer

Once the installation is completed, you can activate the sidebar.

Prerequisites

To use Taleo Sidebar, you must have the following permissions:

• Match candidates to requisitions 

Path: Administrator WebTop > SmartOrg > User Type List > Candidates tab

• Capture resumes 

Path: Administrator WebTop > SmartOrg > User Type List > Other tab

• Access Quick Search and Specific Search

Path: Administrator WebTop > SmartOrg > User Type List > Search tab
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1. Open Internet Explorer.

2. Click View > Explorer Bar > Taleo Sidebar. If you have not already signed into Taleo Sidebar and 
you have never selected Remember Me, the system might request you to sign in.

Taleo Sidebar is displayed on the left side of the Web page.
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Configuring Taleo Sidebar

From within the Taleo Sidebar Configuration window, you can define the language in which you want to 
use the application, specify recruiting options, reset your user name and password and change the 
Taleo hostname.

1. Click Options on the Taleo Sidebar. The Taleo Sidebar Configuration window opens.

2. Click the language selector and then click the language you want Taleo Sidebar to use Taleo 
Sidebar. Click OK. Taleo Sidebar will use the language you selected the next time you start Internet 
Explorer.

3. Click Recruiting Options... to specify the following options:

a. Requisition default title field: Specify if you want to display requisitions with the Recruiter Title or 
the Manager Title (as defined in the requisition’s Logistics tab).

b. Candidate default language: Specify the default language for the candidate’s resume. When 
creating a candidate, the language selected here will appear automatically in the Candidate 
Resume Language field. The languages in this list are identical to the languages specified in the 
database (company setting: CompanyContentLanguages). If only one language is activated on 
the zone, the drop-down list is not visible.

c. Candidate default country: Specify the country of the candidate. When creating a candidate, the 
country selected here will appear automatically in the Candidate Information window.

Click OK when you are satisfied with your changes.

4. Click Reset Username/Password to reset the user name and password for Taleo Sidebar. The system 
will request you to enter the new username and password the next time your use Taleo Sidebar.

The Reset Username/Password function is common to Taleo Sidebar and Taleo Inbox. Therefore, if 
you change your user name or password in Sidebar, you have to use the new values when you log 
into Inbox and Sidebar.

5. Click Change Taleo Hostname to enter the Taleo hostname used by your organization.

6. Click OK when you are satisfied with your changes. 



Creating a Candidate

Taleo Sidebar enables you to copy and paste a resume or to select and drag it to the box provided.

Obtaining a Candidate’s Information from a Web Page

Prerequisite

Taleo Sidebar is displayed in Internet Explorer.

1. Access a job board or another online source.

2. Copy the candidate’s resume to memory, click the text box in Taleo Sidebar and then paste the 
resume in the box. Alternatively, select the resume text on the Web page and then drag it to the text 
box; the text is reproduced automatically in Sidebar.

3. In the Candidate Resume Language, click the language of the candidate’s resume.

4. Click Next.

Entering Personal Information

1. Enter the candidate’s contact information. You can copy the information from the resume and paste 
it into the appropriate fields or you can select the information in the resume and then drag it into the 
appropriate fields. The First Name, Last Name and Email fields are mandatory.

2. Click Next. A duplicate check on the candidate’s email address is performed to see if the candidate 
already exists in the database.

If the email address is found in the database, you will have to log into Recruiting to verify whether 
your candidate is in fact already in the system. 

 

Matching a Candidate to a Requisition

Prerequisite

You must be the owner of the requisition to perform the steps in this section.

1. In the Match Requisition window, enter your search term in the Search Requisition field, select a 
search category from the corresponding field (“All fields”) and then click Search.

If you enter multiple search terms, they are joined by the AND operator (this action is transparent). 
You can use word stems composed of at least 3 characters. For example, you can type “eng” and 
the search engine will retrieve requisitions that contain “English”, “engine”, “engines”, 
“engineering”, “engineer”, etc. If you use multiple search terms, stemming is only applied to the last 
term in the search string.

2. In the Search Results list, click the requisition to which you want to match the candidate and then 
click Add. You can CTRL-click multiple requisitions to select them before clicking Add if you want to 
match the candidate to them.
Taleo V7.5, Taleo Anywhere 3-6



3. Click Next.

4. On the Select Source section, make the appropriate selection from the Source Type and Source 
fields. 

5. Click Finish and then click OK.

Result: The candidate is available in the database and, if applicable, is matched to the requisitions you 
specified.
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RSS Job Feeds

Taleo clients can create career sections that enable candidates to create RSS job feeds. 

Key Benefits

• Visitors to a Taleo client’s career section who create RSS job feeds are kept up-to-date on a daily 
basis on openns at the organization that meet the Job Field, Location and/or Work Location search 
criteria they entered.

• Candidates can use one of the major Internet browsers or a dedicated RSS reader to view and apply 
for positions at the Taleo client’s career section. 

Candidates can create multiple RSS job feeds at one Taleo client’s career section or at the career 
sections of multiple Taleo clients.

Things to Consider

• RSS feeds are cached on servers and the servers are cleared once a day. Consequently, RSS Feeds are 
refreshed every 24 hours.  

Adding RSS Job Feed Functionality to a Career Section

Prerequisite: Because Taleo’s RSS feeds do not support authentication at the present time, RSS can be 
activated on unsecured career sections only.

Path: Administrator WebTop > Career Sections > Career Sections

1. Click the name of the career section that will offer candidates the possibility of creating RSS job 
feeds to their Facebook profile.

2. If the career section has Active status, click Deactivate next to the career section title.

3. Click Edit next to Properties.

4. If the Enable the RSS feature is set to No, click the field and then click Yes.

5. Click Save to save your changes.

6. Click Activate next to the career section name to reactivate the section.

Creating an RSS Job Feed 

Candidates perform the following steps to create RSS job feeds.

Prerequisite: A Taleo client career section for which the Enable the RSS feature setting has been set to 
Yes.

1. Click the Job Search tab if the tab is not displayed automatically.
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2. Click the Basic Search tab or the Advanced Search tab and perform your search using only criteria 

whose fields have the  icon. The system displays the search results.

3. To create the RSS job feed, click . 

Whether you use an Internet browser that offers RSS feed capability or a dedicated RSS reader, jobs at 
the career section that correspond to the Job Field, Location and Work Location values you specified 
earlier will be retrieved by your application daily.

Modifying RSS Labels and Messages

Path: Administrator WebTop > Career Sections > Career Sections > (click the career section you want 
to modify) >Show (Career Portal Pages) > Edit User-defined Labels

1. On the User-defined Labels page, click Show and select RSSFeedPageResources.

2. Click Refresh.

3. Click the name of the resource you want to modify.

4. Click Edit.

5. Enter the text you want to assign to the label in the Override field and click Save. On the User-
defined Label page, the new value is displayed in the Override field.
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Sharing Job Postings on 
Facebook

Feature Description

Facebook support enables candidates to be informed of new jobs as they become available and to 
share those job postings with friends who might be interested in applying. The job postings correspond 
to the Job Field, Location and Work Location search criteria the candidates indicated while performing 
a job search on the Taleo client’s career section.

Key Benefits

• The (Taleo) Job Openings application in Facebook ensures that the jobs Taleo clients post reach a 
wider audience (younger job seekers in particular) via this popular social network.

• Candidates can share job postings with friends who might be interested in applying.

• Candidates receive news on a daily basis of new jobs as the latter are posted. 

• The jobs correspond to the Job Field, Location and/or Work Location search criteria a candidate 
specified prior to clicking the Facebook icon and originate from that particular career section. 

• Candidates can perform multiple searches on a Taleo client’s career section and create an RSS 
feed for Facebook for each one. 

• Candidates can create RSS feeds for Facebook from the career sections of multiple Taleo clients.

Things to Consider

• When candidates perform a search for a job in the career section and then click the Facebook 
icon, this action creates a new Facebook application called Job Openings in the candidates’ 
Facebook account (if the candidates are not already logged into their Facebook account, they are 
prompted to log in or to create a new account). Afterward, the Job Openings Facebook 
application retrieves daily the RSS feed based on the Job Field, Location and Work Location 
search criteria the candidate used in the career sectioning updated list of job postings that 
correspond to the search criteria the candidate entered is displayed.

• Users can specify in the (Taleo) Job Openings application in Facebook if they want their Facebook 
friends to see the job openings they have on their Facebook “wall”.

• Facebook users can configure the number of jobs they want Facebook to display, between three 
and eight (the default is five). If more than eight jobs correspond to the search criteria, the 
Facebook application retrieves the eight most recently posted listings.

• Because Taleo’s RSS feeds do not support authentication at the present time, RSS can be activated 
on unsecured career sections only.
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Adding Facebook Support to a Career Section

Prerequisite: Because Taleo’s Facebook feeds do not support authentication at the present time, 
Facebook can be activated on unsecured career sections only.

Path: Administrator WebTop > Career Sections > Career Sections

1. Click the name of the career section that will offer candidates the possibility of adding RSS job feeds 
to Facebook.

2. If the career section has Active status, click Deactivate next to the career section title.

3. Click Edit next to Properties.

4. If the Enable the Facebook feature is set to No, click the field and then click Yes.

5. Click Save to save your changes.

6. Click Activate next to the career section name to reactivate the section.

Adding an RSS Job Feed to Facebook 

Candidates perform the following steps to add RSS job feeds to Facebook. The steps as described here 
assume that the candidates already have a Facebook account.

Prerequisite: A Taleo client career section for which the Enable the Facebook feature setting has been 
set to Yes.

1. Click the Job Search tab if the tab is not displayed automatically.

2. Click the Basic Search tab or the Advanced Search tab and perform your search using only criteria 

whose fields have the  icon. The system displays the search results.

3. To add the RSS job feed to your Facebook profile, click .

4. In the new window that opens, log in to Facebook using the email address and password on file at 
Facebook. 

5. On the Request for Permission page, click Allow. (This step is necessary since Facebook introduced 
more robust security policies.)

6. Candidates can perform a number of operations in Job Openings such as: 

• Click a link on the Job Openings page to view a job posting.

• Click Share next to a job posting to post the job on your profile or send news of the job to a friend.

• Share all their job postings with friends by clicking Share with friends and selecting the friends.

Modifying Job Openings Labels as Displayed in Facebook

If your organization wishes to change the default labels used in the Job Openings application in 
Facebook, please contact Taleo Support. 
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Displaying a Job Feed on a 
Facebook Profile

Feature Description

Facebook users can configure their Facebook profile so that specific job feeds are displayed there.

Key Benefits

• Facebook users can keep up-to-date regarding job opportunities at an organization via daily job 
feeds. They can share specific jobs with friends (who might not even have a Facebook account) 
and can select the level of privacy for sharing with their network.

• Facebook users can display jobs from job feeds on their wall.

Adding a Job Opening to Your Facebook Profile 

Prerequisite

The following steps assume you already have a Facebook account.

Facebook > Profile

Steps

1. On your Facebook Home page, click Applications.

2. Type Job Openings in the Search field and click .

3. In the Applications section of the search results, click Taleo’s Job Openings application and install it.

Next Step

You typically visit the career section of a Taleo client that activated the Facebook feature and you create 
a job feed there.

Creating a Job Feed and Adding It to Your Facebook Profile

Prerequisite

The following steps assume you already have a Facebook account and have installed Taleo’s Job 
Openings application in your Facebook account.

The Taleo client must have activated the Facebook feature for the career section.

Steps

1. Go to the Taleo client’s career section and perform a job search that includes Location and/or Job 
Field fields (a Facebook icon should be displayed on the corresponding tabs).
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2. Click the Facebook icon located in the same row as the Search for Jobs icon. Facebook opens 
(typically in a separate window). 

3. Log into your Facebook account. Facebook displays the Job Openings page and the job feed you 
selected in the previous step. (If you added other job feeds from the same client or from other Taleo 
clients previously, these feeds too are displayed on the Job Openings page in Facebook.) 

Result

The jobs related to the job feed are displayed on your Job Opening page. (Click Home and then click 
Job Openings in the left column to view them.)

Displaying on Your Wall a Specific Job from a Job Feed

You can display on your Wall tab specific jobs from job feeds and can configure which types of 
Facebook users can view them.

Prerequisite

The following steps assume you added job feeds to your profile.

Facebook > Home

Steps

1. Click Job Openings in the left column.

2. On your Job Openings page, locate a job you want to display on your wall and click the 
corresponding Share icon.

3. Type an introduction or comment in the box if you wish (the text will be displayed on your wall along 
with the job).

4. To define who will be able to view the introduction and the job on your Wall tab, click  and 
make your selection.

5. Click Share. 

Result

The job posting is displayed on your Wall tab and Facebook users who correspond to the selection you 
made earlier can view the job on your wall.

Sharing a Job from a Job Feed Via Email

Prerequisite

You require the email address of the person with whom you want to share news of a particular job.

The following steps assume you added job feeds to your profile.

Facebook > Home

Steps

1. Click Job Openings in the left column.

2. On your Job Openings page, locate a job you want to inform other people about and click the 
corresponding Share icon.
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3. Click Send as a Message instead.

4. Enter the email address of each recipient in the To field, separating each address by a semi-colon if 
there is more than one recipient.

5. Type a message in the Message field if you wish (the text will be included in the email message along 
with the job).

6. Click Send Message. 

Result

The recipient will receive notification of the job opening along with the message you entered earlier.

Removing a Job Feed From Your Job Openings Page

Prerequisite

The following steps assume you added a specific job feed to your Job Openings page.

Facebook > Home

Steps

1. Click Job Openings in the left column.

2. Locate a job feed you want to remove from your Job Openings page and click the corresponding 
“x”.

3. Click OK.

Result

The job feed is no longer displayed on your Job Openings page.
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Adding Job Feeds to Facebook 
Fan Pages

Feature Description

The Facebook Job Openings feature has been expanded to enable administrators to add job feeds to 
one or more fan pages from a Facebook account. 

Key Benefits

• The (Taleo) Job Openings application in Facebook ensures that the jobs Taleo clients post reach a 
wider audience. The ability of clients to now add job feeds to fan pages enables clients to reach 
targeted audiences: candidates who have already expressed an interest in the organization but 
who have not necessarily visited its career section.

• The feature facilitates management of job feeds  because the administrator can publish different 
job feeds to multiple Facebook fan pages through a single administrator Facebook account).

• Visitors to the organization’s Web site can view new jobs as they are published on the fan page via 
job feeds.

• The feature is available to both Taleo Anywhere 7.5 and Taleo Anywhere 10 clients.

Adding the Job Openings Application to Your Organization’s Fan Page

Prerequisite

You must be the administrator of your organization’s fan pages.

You have Job Openings installed on your personal Facebook account.

Facebook > Home

1. Click Ads and Pages on the left side of the Home page.

2. Locate the fan page on which you want to install Job Openings and click the corresponding Edit 
Page.

3. In the More Applications section, click Browse More.

4. In the Search Apps field, type Job Openings and press Enter.

5. Click Job Openings by Taleo.

6. Click Add to my Page.

7. In the window that appears, click the Add to Page that corresponds to each fan page on which you 
want to install Job Openings and click Close.

Next Step

A tab must be added for job feeds to your Organization’s fan page.
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Adding a Job Openings Tab (for Job Feeds) to Your Organization’s Fan Page

Prerequisites

You must be the administrator of your organization’s fan pages.

You have Job Openings installed on your personal Facebook account and added job feeds from your 
organization’s career section.

You have created a fan page - perhaps multiple pages - for your organization.

Job Openings must be installed on the fan page.

Facebook > Home

1. Display the organization’s fan page and click the “+” tab.

2. In the drop-down list, click Job Openings.

Result

The Job Openings tab is displayed.

Next Step

You add job feeds to the organization’s fan page.

Adding Job Feeds to Your Organization’s Fan Page

Prerequisites

You must be the administrator of your organization’s fan pages.

You have Job Openings installed on your personal Facebook account and added job feeds from your 
organization’s career section to it.

You have created a fan page - perhaps multiple pages - for your organization.

Job Openings must be installed on the fan page and you typically add a Job Openings tab to the page.

Facebook > Home

1. Open the Job Openings application.

2. Click Job Openings.

3. Locate a job feed you want to add to a fan page and click the corresponding Link to fan pages link.

4. To add the job feed to a specific fan page, click the corresponding icon. 
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